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Introduction
Overview

This manual guides you through the process of installing the CAD client 
applications: Cisco Agent Desktop, Cisco Supervisor Desktop, and Cisco Desktop 
Administrator. 

The CAD services are integrated into the Cisco Unified Customer Response 
Solutions (CRS) installation program. See the Cisco Customer Response Solutions 
Installation Guide for information on installing Cisco CRS.

After you have successfully installed the CAD desktop applications into a 
properly-configured Cisco CRS environment and licensed the applications, the 
basic functionality of Cisco Agent Desktop, Cisco Supervisor Desktop, and Cisco 
Desktop Administrator are ready to use with no further configuration 
required.Related Documentation

What’s New in This Version

This version of CAD includes the following new features:

■ Support for Microsoft Windows Vista, Business and Ultimate Editions
7
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CAD 6.5 Elements

CAD 6.5 includes the following client applications and services.

Client Applications

Cisco Desktop Administrator

Cisco Desktop Administrator provides centralized administration tools to configure the 
Cisco desktop applications. It supports multiple administrators, each able to configure 
the same data (although not all at the same time; only one person can work in one 
node at any one time to ensure data integrity). 

See the Cisco Desktop Administrator User Guide for more information.

Cisco Agent Desktop

Cisco Agent Desktop is an application that helps agents manage their customer 
contacts. It includes enterprise data, call activity information, reports, a chat client for 
chatting with other agents and supervisors, and an integrated browser window. 

The agent can use a hard IP phone or the Cisco IP Communicator soft phone with 
Cisco Agent Desktop. 

Cisco Agent Desktop controls the telephony activities on the agent's CCX phone line. 
CAD cannot coexist with other applications, such as Cisco Attendant Console and 
Cisco Unified Personal Communicator, that attempt to share or control the agent's CCX 
phone line.

See the Cisco Agent Desktop User Guide for more information.

Cisco IP Phone Agent

Cisco IP Phone Agent is a service that runs on the agent’s Cisco IP phone. It enables 
agents to manage their customer contacts without the need of a computer. It includes 
enterprise data, agent states, reason codes, and skill statistics. 

See the Cisco IP Phone Agent User Guide for more information.

Cisco Supervisor Desktop

Cisco Supervisor Desktop allows contact center supervisors to manage agent teams 
in real time. They can observe, coach, and view agent status details, as well as view 
conference information. Without the caller’s knowledge, supervisors can initiate chat 
sessions with agents to help them handle calls. They can also silently monitor and 
record customer calls and, if necessary, conference in or take over those calls using 
the barge-in and intercept features. Through the Supervisor Record Viewer, 
supervisors can play back and save recorded agent calls.
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See the Cisco Supervisor Desktop User Guide for more information.

Services

The following are the individual CAD services that are installed on the Cisco CRS 
server as part of the Cisco CRS installation. 

The group of services referred to as the “CAD Base services”, which are always 
installed on the Cisco CRS server, include the following:

■ Chat service

■ Directory Services

■ Enterprise service

■ IP Phone Agent service

■ LDAP Monitor service

■ Licensing & Resource Manager service

■ Recording & Statistics serve

■ Sync service

Chat Service

The Chat service acts as a message broker between the Chat clients and Supervisor 
Desktop. It is in constant communication with all agent and supervisor desktops.

Agents’ desktops inform the Chat service of all call activity. The service, in turn, sends 
this information to all appropriate supervisors. It also facilitates the sending of text 
chat and team performance messages between agents (excluding IP Phone agents) 
and supervisors.

Directory Services

All other Cisco Desktop services register with Directory Services at startup. Clients use 
Directory Services to determine how to connect to the other services. 

The majority of the agent, supervisor, team, and skill information is kept in Directory 
Services. Most of this information is imported from Cisco CRS and kept synchronized 
by the Sync (Synchronization) service.

Enterprise Service

The Enterprise service tracks calls in the system. It is used to attach IVR-collected 
data to a call in order to make it available at the agent desktop. It also provides 
real-time call history.
September 2007 9
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IP Phone Agent Service

The IP Phone Agent (IPPA) service enables IP phone agents to log in and out of CRS, 
change agent states, and enter reason codes and wrap-up data without having the 
Agent Desktop software.

This service works in conjunction with the Services feature of Unified CM and 
supported Cisco IP phones.

LDAP Monitor Service

The LDAP Monitor service starts Directory Services and then monitors it to ensure that 
it keeps running. It also sets up the configuration for LDAP replication, and 
resynchronizes LDAP data.

Licensing & Resource Manager Service

The License & Resource Manager (LRM) service distributes licenses to clients and 
oversees the health of the CAD services. In the event of a service failure, it initiates 
the failover process.

Recording & Playback Service

The Recording & Playback service extends the capabilities of the VoIP Monitor service 
by allowing supervisors and agents to record and play back calls. 

Recording & Statistics Service

The Recording & Statistics service maintains a 1-day history of agent and team 
statistics, such as average time an agent is in a particular agent state, last login time, 
number of calls an agent has received. It maintains a rolling 7-day history of 
recordings (unless they are saved, in which case they are saved for 30 days).

Sync Service

The Sync service connects to Unified CC Express via ACMI and retrieves agent, 
supervisor, team, and skill information. It then compares the information with the 
information in Directory Services and adds, updates, or deletes entries as needed to 
stay consistent with the Unified CC Express configuration.

Voice-Over IP Monitor Service

The Voice-Over IP (VoIP) Monitor service enables supervisors to silently monitor 
agents. The service accomplishes this by “sniffing” network traffic for voice packets.

Multiple VoIP Monitor services can be installed in one logical contact center to ensure 
there is enough capacity to handle the number of agents.
10 September 2007
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CAD Feature Levels

There are three feature levels of CAD: Standard, Enhanced, and Premium. The 
following chart outlines the features available at each level. All features not listed here 
are present in all three levels.

Standard Enhanced Premium

Cisco Agent Desktop

Task buttons ● ●

Event-triggered work flows ● ●

Enterprise data thresholds ● ●

Integrated browser ●

Reason codes ● ● ●

Agent-initiated chat ● ● ●

Automated recording (part of a work 
flow)

● ●

Cisco IP Phone Agent

Agent-initiated recording ● ●

Caller data ● ● ●

Reason codes ● ● ●

Contact service queue statistics ● ● ●

Work agent state ● ●

Cisco Supervisor Desktop

Silent monitoring ● ●

Barge-in ● ●

Intercept ● ●

Recording (up to 32 simultaneous 
recordings/playbacks)

● ●

Team Messages ● ● ●

CSQ statistics ● ● ●
September 2007 11
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Reports ● ● ●

Cisco Desktop Administrator

Configure CAD interface ● ●

Configure work flows ● ●

Configure integrated browser ●

Agent work flow HTTP Post/Get 
Action

●

Standard Enhanced Premium
12 September 2007



Localization
Localization

In CAD 6.5, the CAD desktop applications are localized in the languages displayed in 
Table 1.

Table 1. CAD applications and supported languages.

Language CAD CSD IPPA CDA

Chinese (Simplified) × ×

English (US) × × × ×

French × × ×

German × × ×

Italian × × ×

Japanese × × ×*

* IP Phone Agent does not support Japanese if it is running on a SIP phone. Reason codes must be 
Katakana half-width in Shift-JIS format. Kanji will not display properly.

Spanish × × ×
September 2007 13
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Before You Install CAD 6.5
System Configurations

Supported system configurations are documented in the Cisco Unified Contact 
Center Express Solution Reference Network Design (SRND), available for 
download on www.cisco.com. 

Configuration Sizing

Use Table 2 as a guideline for selecting the correct configuration for your contact 
center..

Citrix and Microsoft Terminal Services Environments

CAD is supported in Citrix and Microsoft Terminal Services environments. See the 
document, Integrating CAD Into a Citrix MetaFrame Presentation Server or 
Microsoft Terminal Services Environment, located at:

http://www.cisco.com/en/US/docs/voice_ip_comm/cust_
contact/contact_center/cad_enterprise/cadenterprise7_
2/installation/guide/CADCitrixMTS.pdf

Table 2. Configuration Sizing Guidelines

No. Agents
Base Services and  
Recording & Statistics Service VoIP Monitor Service

1–150 Coresident with CRS Coresident with CRS

151–300 Coresident with CRS Dedicated server
15
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System Requirements

CAD 6.5 is integrated into the following environment:

■ Cisco Unified CallManager 4.3

■ Cisco Customer Response Solution (CRS) 6.0(1)

Consult the Cisco Unified CallManager Compatibility Matrix for the appropriate 
versions of other Cisco applications required in your contact center environment. The 
compatibility matrix is located at:

www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/ccmcomp.htm

Operating Environment

CAD 6.5 runs on the following minimum operating systems and hardware.

Table 3. Desktop application minimum operating systems and hardware

Operating System Hardware

Windows 2000 Professional 
Service Pack 4

500 MHz processor
128 MB RAM
650 MB free space
100 Mbit NIC supporting Ethernet 2

Windows XP Professional
Service Pack 1 and 2

500 MHz processor
128 MB RAM
650 MB free space
100 Mbit NIC supporting Ethernet 2

Windows Vista Business or Ultimate 800 MHz processor
512 MB RAM
650 MB free space
100 Mbit NIC supporting Ethernet 2

Citrix MetaFrame Presentation Server 3.0 and 
4.0, full window mode

Refer to Citrix documentation for minimum 
hardware requirements

Microsoft Terminal Server for Windows 2003 Refer to Microsoft Terminal Server 
documentation for minimum hardware 
requirements

Table 4. Server minimum operating systems and hardware

Operating System Hardware

Windows 2003 Server 2.8 GHz processor
2 GB RAM
1 GB free space
100 Mbit NIC supporting Ethernet 2
16 September 2007
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System Requirements
Operating Environment Language Requirements

The CAD services must be installed on machines running an English language 
operating system.

Cisco Agent Desktop and Cisco Supervisor Desktop can be installed on machines 
running localized operating systems. For a list of supported languages, see 
"Localization" on page 13.

Cisco Desktop Administrator is always installed on the CRS server, which runs an 
English language operating system. However, in a non-English language environment, 
it is necessary to run a second instance of Cisco Desktop Administrator on a machine 
with a localized operating system so that chat messages, tooltips, enterprise data 
names, and other communications within the contact center are in the local language.

A site cannot support more than one localized language. All agents and supervisors 
must use the same language—there cannot be some agents and supervisors using 
one language and other agents and supervisors using another language. 

Third Party Software Environment

CAD 6.5 requires the following software applications to run successfully:

Table 5. Third party software requirements 

Application Where Installed/Description

Apache Tomcat 5.5 Cisco CRS server

Tomcat is a Java-based webserver. If 
you are installing IP Phone Agent, it is 
needed to work with the XML pages 
displayed by IP phones. More 
information about Tomcat can be found 
at http://jakarta.apache.org. Tomcat is 
shipped with CAD 6.3 and is 
automatically installed.

Microsoft Internet Explorer 6 or 7 Client desktops

Internet Explorer is required for the 
integrated browser portion of Cisco 
Agent Desktop and Cisco Supervisor 
Desktop/ The integrated browser 
makes use of a Windows OS library 
distributed with the Microsoft IDEs that 
supports the rendering of HTML.
September 2007 17
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Java Runtime Environment (JRE)  
1.5.13

Cisco CRS server

JRE is required to run the Java applets 
and JavaServer pages (JSP) used by 
Cisco IP Phone Agent. JRE is shipped 
with CAD 6.5. It is installed 
automatically with the CAD services. 

Table 5. Third party software requirements — Continued

Application Where Installed/Description
18 September 2007



Monitoring Requirements
Monitoring Requirements

All Monitoring

CAD supports the G.711 and G.729 codecs. Silent monitoring and recording will not 
function correctly if IP phones use any other codec. 

Consult the Cisco Unified CM documentation for information on changing a phone 
device’s codec.

Desktop Monitoring

The use of desktop monitoring in your contact center increases bandwidth 
requirements. Consult the best practices document, Cisco Agent Desktop Bandwidth 
Requirements, for more information.

Required Device Settings for Desktop Monitoring

The following device settings are required for desktop monitoring to function correctly 
with CAD. The settings are configured with the Cisco Unified CM Administration 
application.

NOTE:  Not all devices or Unified CM versions use all these settings. 
Configure those that do appear for your device and Unified CM 
version.

NOTE:  CAD does not support Secure Realtime Transport Protocol 
(SRTP) in desktop monitoring.

In the Product Specific Configuration section of the Device Configuration page, 
configure these settings as follows:

■ PC Port—Enabled. If the PC Port is not enabled, the agent PC that is 
connected to the port will not have network access. No voice streams will be 
seen by the desktop monitor module.

■ PC Voice VLAN Access—Enabled. If the PC Voice VLAN Access is not enabled, 
no voice streams will be seen by the desktop if the desktop is not a member 
of the same VLAN as the phone.

■ Span to PC Port—Enabled. If the Span to PC Port is not enabled, the voice 
streams seen by the phone will not be seen by the desktop monitor module.

In the Device Information section of the Device Configuration page, configure this 
setting as follows:
September 2007 19
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■ Device Security Mode—Non-Secure or Authenticated. If the Device Security 
Mode is set to Encrypted, the voice streams can be seen but will not be 
converted correctly, causing the speech to be garbled.

Qualifying NICs for Desktop Monitoring

Desktop monitoring does not function with some NICs. The Intel PRO/100 and 
PRO/1000 NIC series are unable to detect both voice packets and data packets in a 
multiple VLAN environment, which prevents desktop monitoring from functioning 
properly. These NICs do not fully support NDIS Promiscuous Mode settings.

A list of NICs tested with Cisco Agent Desktop is located on the Cisco website at:

http://www.cisco.com/en/US/partner/products/sw/custcosw/ps14/prod_
installation_guides_list.html

A workaround solution for the problems with the Intel PRO/100 and PRO/1000 NICs is 
available from the Intel Technical Support website (Solution ID: CS-005897). Other 
solutions include:

■ Monitoring agents via a VoIP Monitor service

■ Using another type of NIC that is fully NDIS-compliant

The workaround described in CS-005897 might not work for some newer Intel 
PRO/100 and Intel PRO/1000 cards and drivers.

If the workaround does not solve the problem, the VLAN ID of the IP phone to which 
the agent computer is directly connected must be added to the VLANs tab of the Intel 
NIC’s Network Connection Properties dialog box.

The IP phone’s VLAN ID can be obtained from the phone’s Network Configuration 
screen (press Settings and then choose Network Configuration). See the 
documentation specific to your version of Cisco Unified Communications Manager and 
IP phone model for more information.

You can test a NIC to verify that it is suitable for desktop monitoring by following the 
procedure, “Qualifying Ethernet Cards for Cisco Agent Desktop Monitoring” (Document 
ID 46301). This document is located on the Cisco website at:

http://www.cisco.com/en/US/partner/products/sw/custcosw/ps1844/produ
cts_tech_note09186a00801f42f9.shtml

A sample packet capture file used in this procedure is located at:

http://www.cisco.com/cgi-bin/tablebuild.pl/nic-qual
20 September 2007
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Desktop Monitoring Hardware Setup

For desktop monitoring to function, the phone is connected to the network, and the 
agent PC is daisy-chained to the phone (see Figure 1).

NOTE:  Desktop monitoring of multiple phones daisy-chained to the 
agent PC is not supported. 

NOTE:  An agent should log into CAD using the extension of the phone 
daisy-chained to the agent PC for desktop monitoring to function. 

Figure 1. Desktop monitoring hardware setup

Server Monitoring

The following device setting is required for server monitoring to function correctly with 
CAD. The setting is configured with the Cisco Unified Communications Manager 
Administration application.

In the Device Information section of the Device Configuration screen, set the Device 
Security Mode to Non-Secure or Authenticated. If it is set to Encrypted, the voice 
streams can be seen but will not be converted correctly, causing the speech to be 
garbled. 

NOTE:  CAD does not support Secure Realtime Transport Protocol 
(SRTP) in server monitoring.

network connection
phone/PC
connection
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Recording Requirements

NOTE:  The CAD recording functionality is intended for “on demand” 
use only, and not for recording all calls in the contact center. 

The space requirements for the Recording & Playback service and the Recording & 
Statistics service depend on the size of the contact center. In general, requirements 
are as follows:

Agent Data Store Database

The Agent Data Store database (the MSDE database associated with the Recording & 
Statistics service) requires 1.2 GB to store agent state and call activity records for a 
7 days per week/10 hours per day contact center with 150 agents taking calls that 
last 1 minute each.

Recording & Playback Service

The Recording & Playback service requires the following space.

■ ~800 kB for each minute of a recorded G.711 voice call

■ ~200 kB for each minute of a recorded G.729 voice call

■ 2.6 GB to store voice calls assuming that there are 32 supervisors, each 
supervisor recording 10 G.711 calls per day, each call lasting 5 minutes. This 
space requirement is divided over all Recording & Playback server, because 
they balance the recording load. 

If the audio files are stored on a partition using the FAT32 file system, a limit of 
21,844 objects can be stored. If this recording limit is exceeded, supervisors will be 
unable to record any more audio files. There is no such limitation on an NTFS file 
system partition.
22 September 2007
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Setting Up Agents in Cisco CRS

For CAD 6.5 applications to work properly, your agents must be organized into teams 
and some must be designated as supervisors. This is accomplished in Cisco CRS. See 
your Cisco CRS documentation for information on how to do this.
September 2007 23
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System Capacity

CAD 6.5 supports the system capacities displayed in Table 6.

Table 6. System capacity.

Maximum number of agents per site 300

Maximum number of agents per team 150

Average number agents per supervisor 7.5 : 1

Maximum number of skills/CSQs per agent (for real-time 
reporting)

50

Maximum number of supervisors per site 50

Maximum number of supervisors per team 30

Maximum number of agents per monitor domain 400

Maximum number of simultaneous recordings per Recording 
& Playback service (dedicated server)

32

Maximum number of simultaneous playbacks per Recording 
& Playback service (dedicated server)

80
24 September 2007
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Supported IP Phones

For a list of supported IP phones, see the Cisco Customer Response Solutions (CRS) 
Software and Hardware Compatibility Guide. This document is available on the web at 

http://www.cisco.com/application/pdf/en/us/guest/products/ps1846/c16
83/ccmigration_09186a008072060d.pdf

Caveats on Using a Cisco 7920 Wireless Phone

Only SPAN port monitoring can be used with the 7920 wireless IP phone. The port that 
is to be included in the SPAN is the one to which the access point is wired. 

Due to the nature the 7920 phone’s mobility, there are certain conditions under which 
monitoring and/or recording calls may result in gaps in the voice: 

■ Agent to agent conversations when both agents are using the same wireless 
access point 

■ When an agent roams from one monitoring domain to another

The 7920 phone is not supported as a second line appearance for an agent’s wired 
phone.
September 2007 25
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Saving Employee Phone Books From CAD 4.5 
and Earlier

CAD 6.3 stores employee phone books differently than it did in CAD 4.5 and earlier. 
Instead of being saved in a *.csv file stored on the agent’s desktop, the phone book 
information is stored in LDAP.

The EmployeePhoneBookUploader (PBUploader) utility enables you to preserve the 
employee phone books when upgrading to CAD 6.3. 

If this utility is not run, the employee phone books are lost in the upgrade.

To save employee phone books before an upgrade:

1. Before upgrading the agent’s instance of Cisco Agent Desktop, navigate on 
the agent’s computer to …\Cisco\Desktop\config\.

2. Rename personal.csv to <agent ID>.csv, where <agent ID> is the agent ID the 
agent uses to log in to Cisco Agent Desktop.

The agent ID for an agent can be found under Cisco Desktop Administrator’s 
Personnel Configuration node. See Chapter 5 of the Cisco Desktop 
Administrator User Guide for more information.

3. Copy <agent ID>.csv to a location accessible to the CAD servers.

4. On the CAD server, navigate to C:\Program Files\Cisco\Desktop\bin.

5. Double-click EmployeePhoneBookUploader.exe. 

The PBUploader utility starts (see Figure 2).

Figure 2. PBUploader utility.

6. Click Select Files.
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The Select the Files to be Uploaded window appears (see Figure 3).

Figure 3. Select the Files to be Uploaded window.

7. Navigate to the folder where the employee phone book files were placed. 
Select one file and then click Open. 

The selected employee phone book is uploaded to LDAP. When the upload is 
completed, the utility returns you to the initial window (Figure 2).

8. Select another file, and continue uploading phone books until all are 
uploaded into LDAP.
September 2007 27
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Installation
Overview

In a typical configuration, all CAD services and Cisco Desktop Administrator are 
installed on the Cisco CRS server before the desktop applications are installed.

NOTE:  After you install the CAD services on the CRS server, do 
not change the name of that server. If you do change the 
computer’s name, various required databases and licensing will 
no longer function correctly. To correct this problem, change the 
computer’s name back to the original name and functionality will 
be restored.

This chapter describes the procedure for installing Cisco Supervisor Desktop and 
Cisco Agent Desktop, and the procedure for installing a second instance of Cisco 
Desktop Administrator.

Client Installation Failure

If the installation program for any CAD client application will not run, and you 
receive the error message, “This installation is not fully configured. See product 
documentation for properly configuring your system”, it means that the 
installation programs are not correctly configured through CAD Configuration 
Setup. You must reconfigure the client installation programs.

To correct this problem, follow this procedure. 

NOTE:  In a redundant configuration, you must complete this 
procedure on both the primary and secondary CAD Base Services 
servers.
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To reconfigure CAD client installation programs:

1. Run CAD Configuration Setup on the Cisco CRS server (see "CAD 
Configuration Setup Utility" on page 37 for more information).

2. From the menu, choose File > Reset Client Installs. 

This process reconfigures the client installation programs.

3. When the process is complete, the message, “Client installs reset” is 
displayed. Click OK to close the message.

You can now install the client applications.
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Installing CAD Desktop Applications

Before you install Cisco Agent Desktop, you need to know:

■ The IP address of the CRS server

■ The user ID and password to access the Customer Response Solutions 
Administration web application

■ The destination folder on the user’s PC in which you will install the application

Upgrading From an Earlier Version

To upgrade CAD from earlier versions (except CAD 6.3), you must first remove the old 
version of CAD and then install CAD 6.5.

To upgrade from CAD 6.3, you can install CAD 6.5 over the top without uninstalling 
CAD 6.3.

If there are employee phone books from CAD 4.5 or older, they will be lost in the 
upgrade process unless you preserve them before you uninstall the old version of 
CAD. To preserve them, see "Saving Employee Phone Books From CAD 4.5 and Earlier" 
on page 26.

Installation Procedure

The CAD desktop applications can be installed either of two ways:

■ The desktop applications can be “pushed” to the agent desktops using an 
automated distribution package

■ The agent can install the application from the Customer Response Solutions 
Administration web application

NOTE:  Non-administrative users can now install CAD desktop 
applications using the MSI-based installation packages.

When you install CSD, it automatically installs CAD as well on the desktop. If you 
already have CAD installed on a desktop and want to install CSD, you must first 
uninstall the existing instance of CAD.

Installing a CAD Desktop Application

The CRS Administrator download page includes installation files for all CAD desktop 
applications. The CRS Administrator web page, when accessed using a supervisor 
username and password, contains only the installation file for CSD. The CRS User web 
page contains only the installation file for CAD. 
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If you do not want agents and supervisors to access the CRS Administration web 
application as administrators, direct them to one of the alternatives given in the 
following procedure.

To install a CAD desktop application:

1. Open your web browser and access the appropriate CRS application. Use the 
IP address or hostname of the Cisco CRS server in the URLs listed below.

■ If you are an administrator, complete the following steps.

a. Access http://<Cisco CRS server>/appadmin.

The CRS Administration Authentication page appears.

b. At the prompt, enter your username and password, then click Log On.

The CRS Administration home page appears.

c. From the Tools menu, choose Plug-ins.

d. On the Plug-ins page, click Cisco Unified CCX.

■ If you are a supervisor, complete the following steps.

a. Access http://<Cisco CRS server>/appsupervisor.

The CRS Administration Authentication page appears.

b. At the prompt, enter your Cisco Supervisor Desktop username and 
password, and then click Log On.

The Download page appears.

■ If you are an agent, complete the following steps.

a. Access http://<Cisco CRS server>/appuser.

The CRS User Authentication page appears.

b. At the prompt, enter your Cisco Agent Desktop username and 
password, and then click Log On.

The Download page appears.

2. Click the link for the application you want to install. 

The File Download - Security Warning dialog box appears.

3. Click Run to run the installation program.

4. You might see a security warning that the publisher could not be verified. 
Click Run to run the installation program.

You can also save the installation file to your local computer and run it from 
there. 

The InstallShield Wizard starts. Follow the instructions in the wizard to install 
the selected application.
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Using Automated Package Distribution Tools

CAD’s MSI-based desktop application installations can be deployed (“pushed”) via 
automated package distribution tools that make use of the Microsoft Windows 
Installer service.

Requirements

CAD support for automated package distribution depends on compliance with the 
requirements listed below.

Execution

Installations must be executed on the target machine. Deployment methods that 
capture a snapshot of an installation and redistribute that image are not supported.

Per-Machine vs. Per-User Installation

Installations must be deployed on a per-machine basis. Per-user installations are not 
supported.

It might be necessary to ensure per-machine installation via command line. 

Privileges

CAD installations require either administrative or elevated privileges.

By default, Windows Installer installations run in the context of the logged-on user. 

If the installation is run in the context of an administrative account, there is no need to 
enable policies to grant elevated privileges. 

If the installation is run in the context of an account with reduced privileges, then it 
must be deployed with elevated privileges. The target machine must have the 
Windows policy “Always Install with Elevated Privileges” enabled for both the User 
Configuration and the Computer Configuration. When this policy is enabled, Windows 
Installer installations will run in a context with elevated privileges, thus allowing the 
installation to successfully complete complex tasks that require a privilege level 
beyond that of the logged-on user.

Automated Package Installation vs. Manual Installation

Automated installations must use the same files and meet the same installation 
criteria as manually-deployed installations.

CAD MSI packages are located in a specified location (C:\Program 
Files\wfavvid\tomcat_appadmin\webapps\TUP\CAD) on a successfully-installed 
production server and are intended for both manual and automated deployment. 
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Alteration of these files or the use of other MSI files included with the product at other 
locations is not supported.

Installation criteria such as supported operating systems, product deployment 
configurations, installation order, and server/client version synchronization must be 
met. Altering the supplied MSI packages to circumvent the installation criteria is not 
supported.

Multiple Software Releases

Multiple software releases must not be combined into a single deployment package. 
Each CAD software release is intended for distribution in its entirety as a distinct 
deployment. Combining multiple releases (for example, a software package's base 
release and a subsequent service release) into a single deployment package is not 
supported.

Reboots

Any reboots associated with CAD installations are required. If the installation’s default 
reboot behavior is suppressed, the target machine must be rebooted before running 
the installed applications to ensure expected functionality.

Delaying a reboot is not know to be an issue at this time, as long as a reboot occurs 
before launching the installed applications. If it is determined in the future that 
delaying a reboot via command line suppression affects expected behavior, then that 
delayed reboot will not be supported.

Best Practices

Best practices recommendations are listed below.

Windows Installer Logging 

Window Installer logging should be enabled. The installations should be run with the 
following command line argument:

/l*v <logfile path and name>

NOTE:  The logfile path and name must be a location to which the 
installation’s user context has permission to write.

This ensures that any loggable issues are captured efficiently.

Deployment

Each installation package should be deployed using its own deployment package. 
Using separate packages offers faster isolation of potential issues than does a 
composite deployment package.
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Installation and Uninstallation Deployment Packages

The deployment engineer should create and test both an installation and 
uninstallation deployment package. 

This is especially important for service release installations, which must be 
uninstalled before upgrading the underlying software.

Recommended Deployment Preparation Model

1. Use a lab environment to model the pending deployment.

2. Install the servers to obtain valid client installation packages.

3. Manually deploy client installation packages to ensure that the installs are 
compatible with your environment. This will isolate product installation vs. 
automated deployment issues.

4. Create your deployment packages in accordance with the requirements listed 
in "Requirements" on page 33.

5. Test the deployment packages.

6. At deployment time modify your deployment packages, replacing the client 
installation packages from the lab environment with valid client installation 
packages from the production server.
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Repairing CAD

If one of the CAD client or server applications is not functioning properly, you can use 
the Repair function to reinstall it. If you do repair a CAD application, you must also 
repair any service release that has been installed.

To repair a CAD client or server application:

1. In Windows Control Panel, start the Add or Remove Programs tool.

2. In the list of currently installed programs, locate the CAD application you want 
to repair. 

■ CAD client applications are repaired using the listing for the specific 
application (for example, “Cisco Desktop Administrator”).

■ CAD server applications are repaired using the listing for Cisco Unified 
CCX.

3. Click the Click here for support information link to display the Support Info 
dialog box (see Figure 4).

Figure 4. Support Info dialog box.

4. Click Repair. The program will be reinstalled.

5. Repeat Steps 2 though 4 on the CAD service release, if one has been 
installed.
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CAD Configuration Setup Utility

You can use the Cisco Agent Desktop Configuration Setup utility to configure the CAD 
services.

CAD Configuration Setup runs initially as part of the Cisco CRS installation process. 
After initial installation, you can change your configuration settings by launching it 
from Desktop Administrator or running PostInstall.exe (located in the …\Program 
Files\Cisco\Desktop\bin folder on any CAD computer). 

CAD Configuration Setup displays different step windows depending on which host 
computer it runs on. Table 7 shows which step windows appear when CAD 
Configuration Setup is run on a specific host computer. Refer to this table to 
determine where you should run Configuration Setup to change the desired 
configuration setting.

NOTE:  If you run CAD Configuration Setup on a computer that hosts 
only Desktop Administrator, and no other CAD application or service, 
you will receive a message that there is nothing to configure on that 
computer. Run CAD Configuration Setup on another computer that 
hosts CAD services or applications.  

To modify configuration data:

1. Start CAD Configuration Setup.

■ In Desktop Administrator, select the Call Center 1 node in the left pane 
and then choose Setup > Configure Systems from the menu bar.

■ On another CAD host computer, navigate to the …\Program 
Files\Cisco\Desktop\bin folder and double-click PostInstall.exe.

Table 7. CAD Configuration Setup windows displayed per host computer

Step Name Base1

1 Header key: Base—Base services; VoIP—VoIP Monitor service: Rec—Recording service: CAD CSD—
Cisco Agent Desktop, Cisco Supervisor Desktop—CDA: Cisco Desktop Administrator

VoIP Rec
CAD 
CSD CDA

VoIP Network Device Step (page 39) × × ×

Services IP Address Step (page 40) × × ×

Terminal Services Step (page 41) ×
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Configuration Setup starts and displays the CAD Directory Services dialog box.

Figure 5. Cisco Agent Desktop Directory Services dialog box.

2. Ensure that the correct primary (and optional secondary) Directory Services IP 
addresses are entered, and then click OK.

The Cisco Agent Desktop Configuration Setup utility is displayed, with the 
CallManager node selected.

NOTE:  You can press F6 to switch between the left and right pane, 
and the up and down arrows to move up and down the navigation 
tree in the left pane.

3. Select the step window you want to modify from the left pane, enter the new 
data in the right pane, and then click Apply.

■ You can display the step windows in any order you wish.

■ If you modify something in a step window, you must click Apply to save 
your changes before you move on to another window.

4. When you are done making your changes, choose File > Exit from the menu or 
click Close.

CAD Configuration Setup closes.

5. Stop and restart the modified service and all desktops for the change to go 
into effect.
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Configuration Setup Step Windows

VoIP Network Device Step

Figure 6. VoIP Network Device step.

Select the IP address of the network adaptor to which voice packets are sent to be 
sniffed by the VoIP Monitor service (if this is a server box) or the desktop monitor (if 
this is a client desktop).

■ On a VoIP Monitor Service server, it is the IP address of the NIC that is 
connected to the port configured for SPAN.

■ On a client desktop computer, it is the IP address of the NIC on which the 
computer is daisy-chained to the phone.

NOTE:  If you change these settings after initial setup, you must 
restart the VoIP Monitor service or the client application (depending 
on where you run CAD Configuration Setup) to ensure that the change 
is registered with them properly.
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Services IP Address Step

Figure 7. Services IP Address step.

If the computer has more than one IP address, select the IP address of the NIC used 
to connect to the LAN—it must be accessible by the client desktops.

In order to connect to the Unified CM, the IPPA service must have a user ID and 
password. This user ID and password are also set up in Unified CM (xxxsee 
“Configuring Cisco Unified CM IP Phones to Work With IP Phone Agent” in the Cisco 
CAD Installation Guide). You can complete these fields before actually setting up the 
user in Unified CM, but the user ID and password must be identical in both places. If 
they are changed in this window or in Unified CM, they must be changed in both.

NOTE:  If Directory Services is not running when you view this step, 
the IPPA login information cannot be changed.

NOTE:  If you change these settings, you must restart all CAD services 
to ensure that the change is registered with them properly.
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Terminal Services Step

Figure 8. Terminal Services step.

If this installation of Cisco Agent Desktop is installed in a Microsoft Terminal Services 
or Citrix environment, click Yes. If not, click No.
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Changing Cisco CRS Cluster IP Addresses

It might become necessary to change the IP address of a server in the Cisco CRS 
cluster. When this happens, you must update the configuration so that the new IP 
address is properly registered.

See the Cisco Customer Response Solutions Administration Guide for this procedure.
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Configuring IP Phones for Cisco IP Phone 
Agent

After all IP agent phones are added to the Cisco Unified CM, you must perform the 
following tasks in Cisco Unified CM Administration so that the CAD phone service 
appears on the IP phone agents’ phones:

1. Create the CAD phone service

2. Assign the new phone service to each IP agent phone

3. Create a Unified CM user and assign to it all the IP agent phones

These procedures can be done before or after CAD has been installed on your system.

NOTE:  In this section, the term “CAD phone service” refers to the IP 
Phone Agent phone service that will appear on IP phone agents’ 
phones. You can name this phone service anything you wish. The 
term “IPPA service” refers to the IP Phone Agent service, the CAD 
service that is installed on the CRS server.

Creating the CAD Phone Service

From the Cisco Unified CM Administration web-based application, follow these steps 
to create the CAD phone service.

If you have a redundant system, you should create two CAD phone services, one for 
each CRS engine server IP address.

To create the CAD phone service:

1. From the menu at the top of the page, click Feature > IP Phone Service.

2. On the Cisco IP Phone Services Configuration page, enter the following 
information:

Service Name. Enter the service name that will appear on the IP agents’ 
phones.

Service Description. Optional. Enter a description of the service.

Service URL. Enter the URL for the service. For example:

http://<IP address>:6293/ipphone/jsp/sciphonexml/IPAgentInitial.jsp

where:

■ <IP address> is the IP address of the machine where the IP Phone Agent 
service is loaded
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■ 6293 is the Tomcat webserver port. If 6293 is not the port number in your 
system, check the port parameter in the file C:\Program 
Files\Cisco\Desktop\Tomcat\conf\server.xml for the correct value.

■ ipphone/jsp/… is the path to the jsp page under Tomcat on the machine 
where the IPPA service is installed.

NOTE:  You will not find a file called IPAgentInitial.jsp at this location; 
there will be a file called IPAgentInitial.class, which contains the 
implementation of the *.jsp file.

NOTE:  The Tomcat webserver is included with the installation.

3. Click Insert to create the CAD phone service. The new service is now listed in 
the shaded box at the left of the page.

Assigning the CAD Phone Service to Agent Phones

Once the CAD phone service is created, each IP phone agent’s phone must be 
configured to use it.

From the Cisco Unified CM Administration web-based application, follow these steps 
to configure each IP phone.

To assign the CAD phone service to agent phones:

1. On the Device menu, choose Phone.

The Find and List Phones window appears.

2. Use the search function to find the phone. Search results are listed at the 
bottom of the page.

3. Locate the phone in the list of results and click the red hyperlink.

The Phone Configuration window appears.

4. Click Subscribe/Unsubscribe Services in the upper right corner of the window.

A popup window for subscribing to services for that device appears.

5. From the Select a Service drop-down list, choose the CAD phone service, and 
then click Continue.

The Service Subscription popup window showing the CAD phone service 
appears.

6. Click Subscribe. 

The CAD phone service is now listed in the shaded box at the left of the page.

Close the popup window.
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Creating a Unified CM User

The next task is to create a Unified CM user, and then add the Unified CM user to the 
Standard CTI Enabled group.

The Unified CM user is used by the CAD phone service to push pages to agent IP 
phones. The Unified CM requires that all page pushes are authenticated. This is 
accomplished by specifying a Unified CM user that is associated with the phones 
running the CAD phone service. 

NOTE:  The Unified CM user ID and password are also entered in CAD 
Configuration Setup and must match what is configured in Unified 
CM. If you change them in Unified CM, you must also change them in 
CAD Configuration Setup. See "Services IP Address Step" on page 40 
for more information.

From the Cisco Unified CM Administration web-based application, follow these steps 
to set up the new Unified CM user.

To create the Unified CM user:

1. From the User menu, choose Add a New User.

The User Configuration window appears.

2. Complete the required fields. Note that that user ID and password fields are 
case sensitive. If your system is set up to require password complexity, be 
sure to choose a password that satisfies those requirements.

3. Select the Enable CTI Application Use check box, and then click Insert.

4. Click Device Association in the shaded box at the left.

The Find and List Phones window appears.

5. Use the search function to locate all phones that are to be associated with the 
user. This should be every IP phone that will be used by an IP phone agent.

6. Select the phone(s) from the search results to associate them with the user, 
select the No Primary Extension check box, and then click Update to complete 
the association.

On the User Configuration window, the phones you selected are listed by their 
MAC addresses under Controlled Devices.

7. Continue until all appropriate IP phones are associated.
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Configuring a One-Button Login for IP Phone Agents

When IP phone agents log in to their phones, they must manually enter their 
username, password, and extension. Unified CM can be configured so that these 
parameters are mapped to a particular phone so that the agent does not have to enter 
them, but can instead log in using one button. One button login can be used in 
conjunction with extension mobility.

For more information, see the Cisco document #60134, Configure a “One Button” 
Login for IP Phone Agents, available on the Cisco website at: 

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_
tech_note09186a008029e6d5.shtml#proc

URL Authentication Parameter

If you are upgrading from CAD 4.5 or earlier, and you changed the default URL 
Authentication parameter in Cisco Unified CM Administration so that authentication 
was faster, you should now change it back to the default parameter. 

This parameter is located on the System > Enterprise Parameters page, in the Phone 
URL Parameters section. It should be:

http://<Unified CM IP address>:6293/ccmcip/authenticate.jsp

NOTE:  You must use the Unified CM’s IP address, not the host name, 
in this URL.
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Removal
Removing CAD 6.5

To remove a CAD application:

1. From the Start menu, click Settings, then Control Panel.

2. Double-click Add/Remove Programs. 

3. From the list, select the application you wish to remove and click 
Add/Remove.

The application is removed. 
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Rolling Back Client-Side Service Releases

There are two types of service releases that can be applied to the Cisco CRS server, 
the service release (SR) and the engineering special (ES), which is an update to an SR. 
Only one type, the SR, is applied to the CAD clients. 

When an ES is applied to the Cisco CRS server, an SR equivalent might or might not be 
applied to the CAD clients. As a result, the numbering of SRs on the server and on the 
clients can become out of step with each other. 

The following chart illustrates a hypothetical series of SRs and ESs applied to a 
configuration.

If ES2 is removed from the Cisco CRS server, that server reverts to the SR1 release 
level. (ESs are cumulative, so when ES2 is removed, so is ES1.) However, the CAD 
clients cannot roll back from SR3 (the equivalent to ES2 on the server) to SR1. 
Instead, SR3 must be removed from the CAD clients so that they revert to the main 
release, and then SR1 applied again. 

NOTE:  If the client desktop is not rolled back to the server SR level, 
the user sees an error message that the client and server are running 
incompatible versions and will not start. 

The client-side SR1 can be applied via True Update the next time the client application 
is started, or installed individually on each client desktop.

To roll back a CAD client-side SR:

1. Roll back the SR on the Cisco CRS server to the desired SR or ES. See your 
Cisco CRS documentation for this procedure.

It is recommended that SRs are rolled back on the Cisco CRS server first in 
order to avoid True Update issues. 

2. On the client computers, use the Windows Add or Remove Programs utility in 
the Control Panel to remove the client-side SR.

CRS Server CAD Clients

Main Release Main Release

SR1 SR1

ES1 SR2

ES2 SR3
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The SR is removed and the client applications are rolled back to the main 
release version. The next time the client application is started, True Update 
detects that an SR is present on the Cisco CRS server and automatically 
updates the client application to the current SR.
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Appendix A:  
Voice-Over IP Monitor Service 
Installation Notes
The VoIP Monitor server application is used to enable the silent monitoring and 
recording features of CAD 6.5. It accomplishes this by monitoring (sniffing) 
network traffic to and from IP phones.

By default, Ethernet switches do not deliver packets to ports other than the 
destination port. However, Cisco Catalyst switches have a feature called Switched 
Port Analyzer (SPAN) which allows copying all traffic from a list of ports or VLANs 
to another port. 

In some cases, a single VoIP Monitor server is not able to handle the traffic in an 
entire contact center for these reasons:

■ The VoIP Monitor server cannot see or identify the voice traffic because of 
the way the network is configured

■ A single VoIP Monitor server cannot keep up with the amount of voice 
traffic in the contact center

The VoIP Monitor server identifies packets by MAC address. When a request 
comes in to monitor or record an agent’s conversation, it retrieves the MAC 
address of the agent’s IP phone from the Cisco Unified CM. 

A problem arises if the VoIP Monitor server, using SPAN, is monitoring an Ethernet 
port that hits a router before it reaches the IP phone. In this case, the VoIP 
Monitor server will not associate that packet with the IP phone because it sees 
the router’s MAC address, not the IP phone’s MAC address. For this reason, the 
ports that SPAN is configured to monitor must be in the same layer-2 domain 
(VLAN/subnet) as the IP phones to ensure that the packets it sees contain the IP 
phone MAC addresses.

Figure 9 illustrates a situation in which more than one VoIP Monitor server is 
required. In this figure, a central office connects two agent offices to the voice 
gateway. The agent offices are separated by a WAN link. 

NOTE:  If you install additional VoIP Monitor servers, the 
Recording & Playback service must be restarted in order to 
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recognize the additional VoIP Monitor servers added since its last 
restart.

A single VoIP Monitor server cannot be placed in the central office because there are 
routers between the central office and the agent offices. If a VoIP Monitor server were 
placed in the central office, it would see the MAC addresses of those routers rather 
than those of the IP phones it is supposed to monitor. 

CAD 6.5 enables network architecture to include multiple VoIP Monitor servers in a 
single logical contact center. When this is done, IP phones are assigned to a specific 
VoIP Monitor server using Cisco Desktop Administrator. 

Figure 9. System architecture that requires more than one VoIP Monitor service.
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When setting up a network and configuring SPAN on a Catalyst switch, follow these 
guidelines:

■ Have separate voice and data VLANs. On many switches, SPAN can be 
configured to monitor a VLAN. The VoIP Monitor server is only interested in 
voice traffic, not data, so this feature can be used to minimize the amount of 
extra traffic that the VoIP Monitor server will bear.

■ On Catalyst 2900XL and 3500XL switches, the VoIP Monitor server and the IP 
phones must be in the same VLAN.

■ When monitoring the entire voice VLAN on Catalyst 4000, 6000, and 6500 
switches, configure SPAN to monitor only the inbound (rx) or outbound (tx) 
packets. Monitoring both types of packets (the default setting) can result in 
duplicate packets being sent to the VoIP Monitor server.

For example, if a voice VLAN setting is 10, and the VoIP Monitor server 
Ethernet port is 2/20, then the Catalyst SPAN command is:

Cat6000> (enable) set span 10 2/20 rx inpkts enable create

(Text you enter is in bold.)

In this example, rx specifies inbound packets only, and inpkts enable allows 
the VoIP Monitor server connected to this port to send and receive normal 
network traffic in addition to the traffic that is sent to it by SPAN. By default, 
this option is disabled. It must be enabled for the server to function properly.

■ Catalyst switches can have varying numbers of simultaneous SPAN ports, 
depending on the model. For example, a 3500XL can have only one SPAN 
port, while a 6000 can have two SPAN ports with the inpkts enable option.

Specific Configuration Examples

Example 1

Single Catalyst 3524XL

In a network configuration where:

■ IP phones are on ports FastEthernet0/1 through 0/5

■ VoIP Monitor server is on port FastEthernet0/10

■ IP phones and VoIP Monitor server are in the same VLAN 

Catalyst 3524XL SPAN commands are:

Cat3524XL(config)#interface FastEthernet 0/10
Cat3524XL(config-if)#port monitor FastEthernet 0/1
Cat3524XL(config-if)#port monitor FastEthernet 0/2
Cat3524XL(config-if)#port monitor FastEthernet 0/3
Cat3524XL(config-if)#port monitor FastEthernet 0/4
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Cat3524XL(config-if)#port monitor FastEthernet 0/5
Cat3524XL(config-if)#exit

Example 2

Single Catalyst 6000

In a network configuration where:

■ IP phones are in VLAN 15

■ VoIP Monitor server is on port 2/10

Catalyst 6000 SPAN commands are:

Cat6000> (enable) set span 15 2/10 rx inpkts enable create

Example 3

Single Catalyst 6000 and Multiple Catalyst 3524XLs, with Gateway-Only Monitoring and 
No Agent-to-Agent Monitoring

In this configuration, the supervisors are interested only in calls going through the 
gateway, so that the network configuration can have a single VoIP Monitor server on 
the Catalyst 6000. Silent monitoring and recording of agent-to-agent calls is not 
required.

In this configuration, the:

■ Voice gateway is directly connected to the Catalyst 6000

■ Catalyst 3524XLs are directly trunked to the Catalyst 6000

■ IP phones are in VLAN 15

■ VoIP Monitor server is on port 2/10 on the Catalyst 6000

The Catalyst 6000 SPAN commands are:

Cat6000> (enable) set span 15 2/10 rx inpkts enable create

Example 4

Single Catalyst 6000 and Multiple Catalyst 3524XLs, with Required Agent-to-Agent 
Monitoring

In this configuration, the supervisors must be able to monitor both gateway and 
agent-to-agent calls. Since agent-to-agent calls on a single 3524XL switch would not 
be visible on the Catalyst 6000, we need to install two VoIP Monitor servers, one for 
each Catalyst 3524XL. 

In this configuration, the:

■ Voice gateway is directly connected to the Catalyst 6000

■ Catalyst 3524XLs are directly trunked to the Catalyst 6000
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For Catalyst 3524XL Number 1:

■ IP phones are on ports FastEthernet 0/1 and 0/4

■ VoIP Monitor server is on port FastEthernet 0/5

■ IP phones and VoIP Monitor server are in the same VLAN

For Catalyst 3524XL Number 2:

■ IP phones are on ports FastEthernet 0/3 and 0/4

■ VoIP Monitor server is on port FastEthernet 0/6

■ IP phones and VoIP Monitor server are in the same VLAN

For Catalyst 3524XL Number 1, the SPAN commands are:

Cat3524XL1(config)#interface FastEthernet 0/5
Cat3524XL1(config-if)#port monitor FastEthernet 0/1
Cat3524XL1(config-if)#port monitor FastEthernet 0/4
Cat3524XL1(config-if)#exit

For Catalyst 3524XL Number 2, the SPAN commands are:

Cat3524XL2(config)#interface FastEthernet 0/6
Cat3524XL2(config-if)#port monitor FastEthernet 0/3
Cat3524XL2(config-if)#port monitor FastEthernet 0/4
Cat3524XL2(config-if)#exit

Example 5

Single Catalyst 6000 and Multiple Catalyst 3524XLs, with Routers Separating the 
Switches

In this configuration, routers separate the various Catalyst switches. Regardless if it is 
necessary or not to monitor agent-to-agent calls, at least two VoIP Monitor servers are 
required, one for each Catalyst 3524XL switch. 

Monitoring on the Catalyst 6000 is not possible because there is a router between the 
Catalyst 6000 and the Catalyst 3524XLs. 

In this case, the implementation of the configuration is the same as for the section 
“Single Catalyst 6000 and Multiple Catalyst 3524XLs, with Required Agent-to-Agent 
Monitoring” above. 

NOTE:  For detailed information on SPAN, see “Configuring the 
Catalyst Switched Port Analyzer (SPAN) Feature” on the Cisco website 
in the Tech Notes section 
(www.cisco.com/warp/public/473/41.html).
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Appendix B:  
Using Multiple NICs with the VoIP 
Monitor Service
Overview

The VoIP Monitor service sniffs RTP traffic from the network and sends it to 
registered clients. This requires support from the switch to which the service is 
connected. 

The VoIP Monitor service must be connected to the destination port of a 
configured SPAN/RSPAN. Any traffic that crosses the SPAN/RSPAN source ports is 
copied to the SPAN/RSPAN destination port and consequently is seen by the VoIP 
Monitor service. 

Not all Catalyst switches allow the VoIP Monitor service to use the SPAN port for 
both receiving and sending traffic. There are switches that do not allow normal 
network traffic on a SPAN destination port. A solution to this problem is to use two 
NICs in the machine running the VoIP Monitor service:

■ One NIC for sniffing the RTP streams, connected to the SPAN port

■ One NIC for sending/receiving normal traffic, such as requests from 
clients and sniffed RTP streams, connected to a normal switch port not 
monitored by the above-mentioned SPAN port.
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Limitations

Since Cisco Unified CM does not support two NICs, using multiple NICs works only in 
configurations where Unified CM is not co-resident with the VoIP Monitor service.

SplkPCap 3.0, the packet sniffing library, works only with NICs that are bound to 
TCP/IP. Make sure the sniffing card is bound to TCP/IP. 
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Issues

The VoIP Monitor service does not specify which NIC should be used when sending out 
packets. This is not a problem when using a single NIC for both sniffing and normal 
traffic. With two NICs, however, normal traffic should be restricted so that it does not 
go through the NIC used for sniffing. Otherwise, the sniffed RTP streams of a 
currently-monitored call might not reach the supervisor because the SPAN destination 
port does not allow outgoing traffic.

To resolve this, use the route command to customize the static routing table so that 
normal traffic does not go through the sniffing NIC. Contact your network 
administrator for details.

An alternative solution is to give the sniffing NIC an IP address that no other host on 
the network uses, and a subnet mask of “255.255.255.0”. Leave the default gateway 
field blank for this NIC’s TCP/IP binding. 
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Installing a Second NIC on a VoIP Monitor 
Service Computer

This procedure applies only to computers running Windows 2000.

1. Install the second NIC in the computer.

2. Start the computer.

3. Make sure that neither adapter is using dynamic host configuration protocol 
(DHCP) to get its IP address.

4. Give the adapters valid IP addresses.

5. Determine which of the two adapters is to be used for sniffing. 

6. Connect the sniffing adapter with the switch SPAN port.

7. Connect the second adapter with a normal switch port that is not monitored 
by the SPAN port.

8. Use the route command to customize the local routing table so that normal 
traffic does not go through the sniffing adapter.

9. Verify that the sniffing adapter is not registered with DNS and WINS by using 
the PING <local host name> command. This ensures that the local name 
always resolves to the normal traffic card IP address.

Required Registry Changes

The installation process offers the user the option to choose the IP address that the 
VoIP Monitor Service will use for normal traffic and the IP address of the network 
adapter that the server will use for sniffing.

However, the installation is such that the user can only specify the IP address of the 
sniffing card. The IP address that the VoIP Monitor Service is receiving requests at is, 
by default, the first one to appear in the system-supplied enumeration.

While this works in a one-NIC scenario, it may be wrong in a two-NIC scenario. If the 
first IP address that appears in the enumeration is the sniffing card then the same 
card would be used for both sniffing and other traffic. This is the situation we are 
trying to avoid by making sure that the correct IP address is written in the CAD service 
registry settings, as outlined in the procedure below.

Second NIC is Present Before Unified CC Express Installation

1. Enter the sniffing card's IP address when asked for the VoIP Monitor Service 
during the installation process.

2. After the installation finishes, make sure the following registry key has the 
normal traffic IP address value:

HKLM\SOFTWARE\Spanlink\Site Setup\IOR HOSTNAME

Second NIC is Installed After Unified CC Express Installation

1. Navigate to the following registry key:
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HKLM\SOFTWARE\Microsoft\WindowsNT\CurrentVersion\ 
NetworkCards

2. Find the newly-inserted card entry.

3. Copy the value in ServiceName.

4. Paste this value in the following registry key:

HKLM\SOFTWARE\Spanlink\VoIP Monitor Server\Config\MONITOR DEVICE

5. Prefix the value with \Device\Splkpc_. This string is case sensitive—it must 
match exactly.

6. Close the Windows registry.
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Installing CAD Services

After you install CAD services on a server that has more than one enabled NIC, or if 
you install a second NIC after the CAD services are installed, run the CAD 
Configuration Setup utility (see "CAD Configuration Setup Utility" on page 37) and 
select the appropriate NIC to use from the Services IP Address window.
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